Keep it in a safe place for future use!

Original operating manual

Software/Firmware version: ZDC 4.2
Creation date: 03-2019
## Contents

1 Zünd Design Center - ZDC

2 Program license
   2.1 License information
   2.2 Hardware key
   2.3 Extending the licence

3 System requirements and compatibility
   Windows
   Mac

4 Before installing on Mac computers
   4.1 Testing compatibility
   4.2 Anti-virus software
   4.3 Disabling and re-enabling Gatekeeper
   4.4 Update expired certificates
   4.5 Performing the installation
   4.6 Creating an installation log

5 Installation, uninstalling
   5.1 Before installation
   5.2 Performing the installation
   5.3 Windows: Delete ZDC
   5.4 Mac: Removing ZDC

6 Before the first use
   6.1 Loading the ZDC plug-in
   6.2 Remembering layers when pasting

7 ZDC overview
   7.1 Design views
   7.2 Controlling 3D view
   7.3 Controlling 3D animation
   7.4 Creating a new template
   7.5 Library
   7.6 Materials
   7.7 Object library
   7.8 Object manager
   7.9 Light settings
   7.10 Model options
   7.11 Fold settings
   7.12 Scene control
   7.13 Export settings
   7.14 Settings

8 Illustrator
1 Zünd Design Center - ZDC

The Zünd Design Center is an Adobe® Illustrator® plug-in for the creation of packaging and three-dimensional POS displays made from folding carton, corrugated cardboard, sandwich panel, PP, PVC, MDF and foam board.

At the core of the ZDC is an extensive library. All included designs are parameterized. This means that you only have to determine the relevant dimensions. All other dimensions are calculated automatically.

- Select a design from the extensive library and enter individual dimensions if needed.
- Complete the design in Adobe® Illustrator® with logos, templates, and other design components.
- Check the three-dimensional folding result of your design at any time in the 3D preview.
- Configure the desired material settings, such as transparency or material thickness, for example.
- Export the design to create a customer presentation or 3D PDF presentations, as an illustration in .png format, an .mp4 video file or a three-dimensional object.

The Zünd Design Center includes creations by well-known packaging designers as well as standard designs (FEFCO). You can also start with an optimized template and create your very own design.

Tip:
Every design is already formatted so that you can import it directly into the Zünd Cut Center without any additional steps.
2 Program license

Depending on the license purchased, you can use the Zünd Design Center for either 1, 3 or 5 years. During this time, you will receive all program and design updates at no extra cost. After expiration of the program license you can no longer use the ZDC. Contact your Zünd partner if you wish to extend the license and observe the information in the subsequent sections.

2.1 License information

The following license information is shown in the Settings on page 43 tab:

1 Program version
2 Hardware key identification
3 Remaining license duration
4 Select unit (mm/inch)
5 Further information (Help/EULA)
6 Minimize the ZDC windows after opening a design
7 Switch dynamic view change on/off
8 Language selection (German/English)

Tip:
When starting the ZDC, a corresponding message is displayed 30 days before your license expires.
2.2 Hardware key

The plug-in only works with a valid hardware key. This hardware key contains the license information required to use the plug-in. Insert the hardware key into an available USB port before starting the Zünd Design Center.

2.3 Extending the licence

Contact your Zünd representative to extend the ZDC license and let him or her know which operating system (Windows or Mac) you are using for the license extension.

Your Zünd representative will make sure you receive the correct license file. Please proceed as follows:

A Insert the hardware key into a free USB port.
B Double click to open the license file (.exe for Windows, .V2C for Mac).
C Confirm the dialogs.

Results

The license extension is applied. You can continue to use the ZDC for another 12 months.
3 System requirements and compatibility

Note:
Check the compatibility of the individual components with every update to your operating system, Adobe® Illustrator® or ZDC!

The Zünd Design Center requires the installation of Adobe® Illustrator®. The plug-in is compatible with the following versions of Illustrator and operating systems:

### Windows

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7 SP1</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Windows 8</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Windows 8.1</td>
<td>X</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Windows 10 (until 1909)</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>

Not supported on Windows 10 versions 1507, 1511, 1607, 1703, and 1709

### Mac

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>OS X 10.14</td>
<td>-</td>
<td>-</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>OS X 10.15</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>X</td>
</tr>
</tbody>
</table>
System requirements and compatibility
4 Before installing on Mac computers

This section contains steps that are required before installing ZDC on Mac computers in order to avoid errors during the subsequent installation process.

4.1 Testing compatibility

Check the System requirements and compatibility on page 9 before you update OSX, Adobe Illustrator, and/or ZDC.

4.2 Anti-virus software

Disable or configure the existing anti-virus software so that new applications not identified by Apple can be installed.

4.3 Disabling and re-enabling Gatekeeper

OSX 10.12 has stricter security guidelines than earlier versions, so that programs not identified by Apple cannot be installed.

A Open the system preferences.
B Click Security & Privacy.
C Click the Lock icon on the bottom left.
D Enter the administrator password and click Unlock. Contact the system administrator if necessary.
E Click on the radio button Anywhere. When the prompt appears, click Allow from anywhere.

It is now possible to install applications without Gatekeeper blocking the installation.

Now install ZDC and then reactivate Gatekeeper by repeating steps A through D and reset the radio button to Mac App Store and identified developers.
Before installing on Mac computers

4.4 Update expired certificates

A Visit https://www.apple.com/certificateauthority/ to download the new WWDR certificate (expires 02/07/23).

B Double-click on AppleWWDRCA.cer on the downloaded certificate.

C Enter the administrator password to open Keychain access.

Keychain access opens. The new certificate is visible. Simply installing the new certificate will not suffice, however. The expired copy of the certificate must also be deleted. Expired certificates are not displayed by default.

D Click on View > Display expired certificates.

The text changes to Display expired certificates. Expired certificates are displayed with a white X in a red circle on the icon.

E Right-click on the expired certificate and select Delete.

4.5 Performing the installation

It should now be possible to install ZDC. Perform the installation as described in Performing the installation on page 13.

If the ZDC cannot be installed despite the steps described in this chapter, please contact your Zünd representative. Have the installation report available to assist in troubleshooting.

4.6 Creating an installation log

A Double-click on the installation file to start the ZDC installer.

B In the menu bar, click on Window > Installation log or press Command+L.

The installation log window opens.

C Continue with the installation until the error occurs. Do not close the ZDC installer.

D Click on the Save icon in the installation log window.

E Send the report to your Zünd representative.
5 Installation, uninstalling

5.1 Before installation

The version numbering changed with the release of ZDC build 324. This means that earlier versions of ZDC, V3 SP0, or older must be uninstalled before ZDC build 324 can be installed.

Tip:
Future versions will not require a clean install. See Windows: Delete ZDC on page 13 and Mac: Removing ZDC on page 13 on how to uninstall.

5.2 Performing the installation

A Download the installation file from www.zund.com/de/download and save locally.
B Insert the hardware key into a free USB port.
C Click on the installation file:
   • ZDCsetup.x.msi for Windows
   • ZDCsetup.x.pkg for Max/OS
D Read and accept the end user license agreement.
E Confirm the recommended installation path.
F Click Install to start the installation.

5.3 Windows: Delete ZDC

A Start the system controls.
B Double-click the software.
C Select the Zünd Design Center from the list of installed programs and then click Delete or Add/ Remove. When a dialog box is displayed, follow the instructions.

5.4 Mac: Removing ZDC

A Open the Finder.
B Navigate to <Local drive>/Library/Programs.
C Delete the folder Zünd Systemtechnik.
D Click Go To in the menu bar while holding down the ALT key.
E Select the entry Library from the dropdown menu.
F Navigate to /Programs.
G Delete the folder Zünd Systemtechnik.
H Enter the administrator password and confirm with OK.
I Right-click on the recycle bin icon in the dock.
J Select Empty recycle bin from the dropdown menu.
Installation, uninstalling

14
6 Before the first use

6.1 Loading the ZDC plug-in
A  Start the program Adobe® Illustrator®.
B  Click on window.
C  Click on Zünd Design Center.

6.2 Remembering layers when pasting
In Adobe® Illustrator®, active the setting Remember layers when pasting before starting work with the ZDC.

Tip:
This setting results in the original layer of an object being automatically copied from another file. When pasting the copied objects, the original layer is created in your current file and the object is placed into this layer.

Requirements
•  In Adobe® Illustrator®, the Layers window is open (Layers > window).
A  Click on the layer control panel in the Layers window.
B  Click on the entry Remember layers when pasting.
Before the first use
7 ZDC overview

Requirements

- In Adobe Illustrator if the ZDC window is open (Window > ZDC).
7.1 Design views

The preview of the selected design is available in five different views:
- Areas marked in pink are not visible in folded state or are located on the inside of the packaging.
- Light blue areas mark the surface of the design.

<table>
<thead>
<tr>
<th>Static 3D view</th>
<th>Fold preview of the design</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Static 3D view" /></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Static 2D view</th>
<th>Cutout design view</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image2" alt="Static 2D view" /></td>
<td>All dimensions that can be altered are shown in green.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Info view</th>
<th>Description of the parameters with tips on entering dimensions</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Info view" /></td>
<td>Notes for this design Width should not be larger than Length. Depth should be the largest dimension.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dynamic 2D view</th>
<th>Dynamic display based on individually entered parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4" alt="Dynamic 2D view" /></td>
<td>Click the button to refresh the view.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Dynamic 3D view</th>
<th>3D view of the design</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="Dynamic 3D view" /></td>
<td></td>
</tr>
</tbody>
</table>
7.2 Controlling 3D view

Hold down the right mouse button and move the mouse up/down

Zoom design in/out

Hold down the left mouse button and move the mouse

Rotate design

Hold down the left and right mouse buttons and move the mouse

Move design
7.3 Controlling 3D animation

You can influence the animation of the design using the following settings:

- Manually run through the animation with the ability to freeze the animation at any point
- Jump to the first frame of the animation
- Reduce animation speed. A negative setting causes the animation to run backward
- Play/pause animation
- Increase animation speed. A positive setting causes the animation to run forward
- Jump to the last frame of the animation
- Start 3D folding animation
- Reset view
- Copy current view to the clipboard

7.4 Creating a new template

Tip:
Use the NEW TEMPLATE function to create your own designs. With the predefined layers, assigning the correct processing method to your drafts is quick and easy. This makes the fold preview for your design much easier.

Click the button NEW TEMPLATE. This opens a new .ai file. It already contains all of the layers and spot colors needed for importing the file into the ZCC.
7.5 Library

1. **Open the PDF design catalog**
2. **Search library** on page 22
3. Display/hide expanded design parameters
4. **Selecting the design** on page 22
5. Available designs, sorted by material
6. Saved favorites
7. **Add/remove favorite**
8. **Open design**
9. Refresh the dynamic display of the design view
10. Reset selection
11. Name of the selected design
12. **Create/delete/select default settings**
13. **Design parameters**
14. Design view
7.5.1 PDF design catalog

The PDF design catalog provides a table overview of all the designs from the library.

7.5.2 Search library

The search makes it quick and easy to find designs using exact dimensions or a name.

Tip:
If you want to package a specific product and do not yet have an exact idea of the packaging, you can search for the minimum required inside dimensions. The search result will include all designs with standard dimensions that match your product.

1 Search result
2 Reset search
3 Search
4 Search parameter

7.5.3 Selecting the design

A Select the desired design from the Library.
B Click the SELECT button.

Results
The design is selected. It is now possible to enter individual parameters and open the design in Adobe Illustrator."
7.5.4 Reset selection

Requirements
- A design was selected from the library with the SELECT button.

Click the button
CLOSE

The selection is canceled and the preview of the design and design parameters is hidden. Select a different design from the library as needed.

7.5.5 Entering individual design dimensions

A  Select a design from the Library.
B  Click the Select button.
C  Input the individual parameters for the design.
D  Click the button.

Results
The Dynamic 2D view is refreshed and displays the design with the custom dimensions.

Tip:
Observe the notes in Info view when entering custom dimensions.
7.5.6 Switching between units
Select one of the two radio buttons in order to display the dimensions of the design in the desired unit:
- Radiobutton Inches
- Radiobutton millimeters

Tip:
If the Import dimensions checkbox in the Open design on page 25 dialog is selected, the dimensions are displayed in the selected unit in a separate layer after opening the .ai file.

7.5.7 Displaying the design dimensions
A Select a design from the Library.
B Click the Select button.
C If necessary, enter dimensions specific to the design.
D Click the Open button.
E Check the Import dimensions checkbox.

Results
The opened .ai file contains a separate layer with the dimensions of the design.

Tip:
Depending on which radiobutton is activated in the Library window, the dimensions are displayed in either inches or millimeters.
7.5.8 Open design

Requirements

- A design was selected from the library with the SELECT button.

Tip:
Change the dimensions of the design before opening if needed. All adjustable dimensions are visible in the preview window in Static 2D view.

Click the button OPEN A dialog with additional settings will open.

1. Name of the selected design
2. Number of individual parts in the design
3. Minimum size of artboard
4. Show design dimensions
5. Select the material and the size of the size of the artboard
6. Design's distance to edge of material
7. Distance of parts from each other (for multi-part designs only)
Tip:
When opening a new design, you have the option of adjusting the size of the selected material. The indicated value corresponds to the dimensions of the artboard onto which the design is placed after opening.
Enter the dimensions of your material here (e.g. cardboard size, dimensions of panel material). By doing this, you are ensuring from the beginning of the project that the design will fit on the desired material. You also have the option of arranging multi-part designs optimally on various boards/panels.

7.5.9 Adding/removing favorites
Requirements
• A design was selected from the library with the SELECT button.

Tip:
Use the function ADD TO FAVORITES to mark frequently used designs as favorites.

Click the button ADD TO FAVORITES
The selected design is added to the list of design favorites.

Click the button REMOVE FROM FAVORITES
The selected design is removed from the list of design favorites.

You can also use the Favorite name field to give custom names to your favorite designs. The original name of the design will be retained and will appear after the user-defined name.
7.5.10 Default settings

Tip:
By creating the default settings, you can save your preferred individual parameters for every design - multiple different designs if needed.

7.5.10.1 Adding presets

Requirements
• A design was selected from the library with the SELECT button.
  A Input individual parameters.
  B Enter a name for the default setting.
  C Click the ADD PRESET button.

7.5.10.2 Deleting default settings

Requirements
• A design was selected from the library with the SELECT button.
  A Select the preset to be deleted from the list.
  B Click the DELETE PRESET button.
7.6 Materials

1. For selecting existing standard materials
2. Saved user-defined materials
3. Input material weight and thickness
4. Color settings for the surfaces, insides and edges of the materials
5. Setting of the corrugation direction for corrugated cardboard and transparency
6. Size of material sheet
7. Material thickness in mm
8. Change the name of the selected material / input name for new material
9. Delete material
10. Apply changes
11. Add material
12. Select material
13. Name of selected material
7.6.1 Select material

Select a material with which the design should be simulated in fold preview. The customer materials you have created yourself or the following default standard materials are available:

- Corrugated boards
- Expanded PVC
- Folding boards
- Kapa board
- Polypropylene boards
- Sandwich boards

A Click on a material from the Standard materials or Customer materials list.
B Click the Select button.

7.6.2 Performing material settings

The appearance of the selected material can be defined with the following settings:

<table>
<thead>
<tr>
<th><strong>Color</strong> (edges, face, inside)</th>
<th>Individual color setting for the edge as well as the outside and inside of the design</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Material thickness</strong></td>
<td>Input of the desired material thickness in mm</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>Input of the material weight in g/m²</td>
</tr>
<tr>
<td><strong>Corrugation direction</strong></td>
<td>Indication of the corrugation direction for corrugated cardboard</td>
</tr>
<tr>
<td>(horizontal/vertical)</td>
<td></td>
</tr>
<tr>
<td><strong>Transparency</strong></td>
<td>Transparency for transparent materials</td>
</tr>
<tr>
<td><strong>Sheet of material</strong></td>
<td>Enter the size of the material or panel</td>
</tr>
</tbody>
</table>

**Important:**
Confirm your selection by clicking on the Apply button.
7.6.3 Add material

A Click the **Add material** button.
   A new entry appears in the list of customer materials.

B Click on the new customer material.

C Enter a designation for the new material in the **Name** field.

D Make all desired settings (color, transparency, corrugation direction, etc.).

**Tip:**
Enter the actual dimensions of your material here (e.g. cardboard size, dimensions of panel material). By doing this, you are ensuring from the beginning of the project that the design will fit on the desired material. You also have the option of arranging multi-part designs optimally on various boards/panels.

E Click the **Apply** button.
7.7 Object library

New objects can be inserted into the active scene with the object library. Use the object manager to edit inserted objects.

1. List of the available objects
2. Places the object in the active scene
3. Object name
4. Object scale factor
5. Selection of the surface properties of the object
7.8 Object manager

Objects in the active scene can be manipulated with the object manager.

1 List of existing objects  
2 Ruler  
3 Rotate the object along the X-/Y-/Z-axis  
4 Move object in X/Y/Z direction  
5 Cloning an object  
6 Delete object  
7 Add object
7.8.1 Add object

Use this function to combine as many 3D objects as you would like in a single scene. For example, multiple small boxes can be placed in a large POS display or many different packagings from a series can be lined up next to one another.

1 Add object button

A Click the **Add object** button.
B Select an .obj file and click on **open**.  
   The new object is inserted into the existing scene. It can be rotated, moved, and scaled as desired.

7.8.2 Cloning an object

A Select an existing object from the list.
B Click the **Clone object** button.
7.8.3 Move objects

Requirements
• The **ADD OBJECT** button adds at least one more object to the originally opened design.

Move objects with parameters
A Select the object to be moved from the list.
B Enter positive or negative parameters for moving, rotating, or scaling.

Move objects with the mouse
A Select the **OBJECT SELECTION** button.
B Mark the object to be moved.
C Press and hold the corresponding mouse button to move the object.
7.9 Light settings

1. Activate/deactivate light
2. Selection of a custom background color
3. Light sources 1-6
4. Adjusting individual light settings

7.9.1 Adjusting individual light settings

By adjusting various light sources you can change the mood of the model rendering in the 3D view.

**Tip:** Each light source must be switched on separately for it to be active.

A. Check the **Activate light** checkbox.
B. Select one of the light sources 1-6.
C. Check the **Activate** check box.
D. Set the desired color, brightness, temperature, mood and position.
E. Repeat steps B-D for other light sources, as needed.
7.10 Model options

1. Model options (tessellation, render mode)
2. Resolution in PPI
3. Axis options
4. Playback options
5. Camera positions
7.10.1 Model settings

**Representation as**
- Wire mesh model: Display of the contour of the design

**Representation as**
- Body model: All objects on the Face Graphics layer are shown on the outside. A shaded surface area in different colours is used in the display for each area.

7.10.2 Resolution options

**Resolution PPI**
The resolution of the textures used can be set from 1-400 ppi. The higher the value, the higher the resolution of the 3D preview.

**Tip:**
Note that the required rendering time increases as the resolution is increased.
7.10.3 Axis settings

The following settings are available for the coordinate axis:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide axes</td>
<td>Do not display coordinate axes</td>
</tr>
<tr>
<td>Small axis display</td>
<td>Show small coordinates axis</td>
</tr>
<tr>
<td>Large axis display</td>
<td>Show large coordinates axis</td>
</tr>
<tr>
<td>Fix axes (None/X/Y/Z)</td>
<td>Lock individual axes</td>
</tr>
<tr>
<td>Rotation around X axis</td>
<td>Rotate design around X axis</td>
</tr>
<tr>
<td>Rotation around Y axis</td>
<td>Rotate design around Y axis</td>
</tr>
<tr>
<td>Rotation around Z axis</td>
<td>Rotate design around Z axis</td>
</tr>
</tbody>
</table>

7.10.4 Playback options

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Animation</td>
<td>Switch fold animation on/off</td>
</tr>
<tr>
<td>Continuous loop off</td>
<td>Switch off looping</td>
</tr>
<tr>
<td>Continuous loop</td>
<td>Switch on looping</td>
</tr>
<tr>
<td>Reverse continuous loop</td>
<td>Play back looping backward</td>
</tr>
</tbody>
</table>

7.10.5 Save camera positions

A Set the desired view in the preview window (see Controlling 3D view on page 19 for more).
B Enter a name for the current view in the Name field.
C Click the Save button.

The new camera position will be shown in the list and will be available for the current design from that point on. If the view is changed, you can restore the camera position at any time by clicking the Select button.
7.11 Fold settings

The animation of the fold preview can be individually set for each path of the crease and V-Cut layers. You can define the folding sequence and enter the angle at which the surfaces are folded.

1. Rotation angle at which the two bordering surfaces are folded together on the selected path.
2. Starting time of the animation in sec.
3. Duration of the animation in sec.
4. Tear the material along the selected path.
5. Open folding sequence menu
6. Confirm entries
7. Overlay of all construction, bending, V-cut, and intersection lines with a white area
7.11.1 Defining folding properties

1. Angle: 90°
2. Angle: 75°
3. Angle: 60°
4. Angle: 45°
5. Angle: 30°
6. Angle: 15°

Tip:
If you do not change the values, all folds will be made simultaneously at a 90° angle.

A. Select at least one path of the crease of V-cut layers.
B. Enter the desired values into the fields Rotation angle, Start time and Animation time.
C. Click the Set button.
7.12 Scene control

A scene contains the location and positioning of one or more objects.

1. **Player window**  
   *Controlling the speed of the 3D animation*

2. **Save scene**  
   Saves the current status of the scene as a *.ZDCP file. The Illustrator document must be saved first.

3. **Load scene**  
   Loads a scene from a *.ZDCP file.

4. **New scene**  
   Creates a new, empty scene.

5. **Update scene**  
   Updates the active scene.

6. **Reset**  
   Moves the objects in the scene to their initial orientation.

7. **Open player window**  
   Opens/closes the player in a separate window. The window can be docked to the ZDC window.
### 7.13 Export settings

1. Selection of export format (PNG, 3D-PDF, DAE, MP4, OBJ, STL, ZCC)
2. Select HotFolder
3. Save .ai file in HotFolder
4. Format-specific settings (e.g., dimensions, duration, frame rate, etc.)
5. Save

**Important:**
Always open a 3D PDF with Adobe Reader and activate the reproduction of 3D content *(Edit > Default settings... > 3D & multimedia > Activate reproduction of 3D content).*
### 7.14 Settings

1. Program version
2. Hardware key identification
3. Remaining license duration
4. Select unit (mm/inch)
5. Further information (Help/EULA)
6. Minimize the ZDC windows after opening a design
7. Switch dynamic view change on/off
8. Language selection (German/English)
8 Illustrator

8.1 Layers

Each design already includes all of the layers necessary for importing the file into the ZCC. Make sure that the correct layer is activated before making any changes.

1. Inside graphics: Design elements for the inside of the design
2. Face graphics: Design elements for the outside of the design
3. Line hiding: Overlay the lines with a white area
4. Artwork: Graphics layers for continuing job processes
5. Register: Registration marks
6. Draw: Drawing contours
7. Score: Score contours
8. Crease: Groove contours
9. Kiss-cut: Kiss-cut contours
10. Punch: Punches
11. Drill: Holes
12. Engrave: Engraving contours
13. V-cut: V-cut contours
14. Bevel-cut: Oblique cut contours
15. Thru-cut: Cutting contours
16. Route: Routing contours
17. 3D preview markers: Definition of the connecting points of multi-part designs

8.2 Spot colors

When you open a design from the library or create a new template, the .ai file contains spot colors that are already defined for each processing method:
When creating your own designs, use the spot colors predefined as contour colors for the respective processing methods. This method makes it easy to quickly recognize how a shape will eventually be processed (cut, creased, etc.).

**Tip:**
Many common RIPs automatically recognize contours with spot colors as objects that should not be printed. In this way, a processing path can be recorded and assigned to a processing method without this contour becoming visible in the printout.
8.3 ZDC tool palette

The standard control panel from Adobe® Illustrator® was expanded with special ZDC tools that simplify the creation of custom designs or the editing of stock designs:

1. Draw line/Ellipse/Arc tool
2. Crease line tool
3. Punch ellipse tool
4. Engrave line/Ellipse/Arc tool
5. Bevel-cut line tool
6. Route line/Ellipse/Arc tool
7. Score line/Ellipse/Arc tool
8. Kiss-cut line/Ellipse/Arc tool
9. Drill ellipse tool
10. V-cut line tool
11. Thru-cut line/Ellipse/Arc tool
12. Tear strip tool A/B/C/D
8.3.1 Displaying hidden tools

Some tools can be expanded to reveal hidden tools. Clicking on the small triangle in the lower right corner of the tool will reveal any tools hidden there.

A  Navigate the mouse pointer to a tool with a small triangle in the lower corner.
B  Click and hold the right mouse button over the visible tool.

Results
The hidden tools are displayed and can be selected.
8.3.2 Partial depth cut

Some ZDC tools support a partial depth cut. The contour drawn with the tool is not cut out completely in the process, but rather the material is only cut down to a user-defined depth.

Tip:
With the partial depth cut, for example, shapes can be cut into the top layer of corrugated cardboard, thus structuring the surface.
8.3.3 Tear strip tools

Tear strip tools allow you to draw professional tear strips with just a few clicks, making it easy to open your packaging. The ZDC offers four different preset types of tear strips, which you can optionally configure further.

1 Tear strips type A
2 Tear strips type B
3 Tear strips type C
4 Tear strips type D
5 Configuration options

Tip:
As soon as you draw a tear strip with the tear strip tool, a new "Tear Strip Lines" layer is automatically created.
9 Tips & tricks

9.1 Individually adapting the design contour

You may use the designs already available in ZDC as a basis and adapt as needed to create your own individual designs.

1 Original design
2 Design with individually adaptable contour

A Open a design from the library to serve as a basis for your project.
B Individually adapt the contour.
9.2 Place design elements

Using the *Face Graphics* and *Inside Graphics* layers, you can simulate the design of your packaging true to life. Place colored surfaces, texts, logos, images etc. in this layer.

1. Face graphics: exterior of the design
2. Inside graphics: interior of the design

A. Activate either the Face Graphics layer or Inside Graphics layer.
B. Place the shapes, graphics, or text. The plug-in supports all functions performed in Adobe Illustrator.
9.3 Creating cut-outs

1. Cut-out, cutting contour on the thru-cut level
2. Groove contour on the crease level
3. Section of the groove contour to be removed

A. Open the design for which you would like to create a cut-out.
B. Activate the thru-cut level.
C. Draw the desired contour for the cut-out.
D. Remove the contours of the crease levels that pass through the cut-out.